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Terminology  
This manual uses the following terminology: 

¶ design: a powerONE design that contains design elements such as Rpm, Leds and more 

¶ design element: a specific element in a design, such as a Led 

¶ powerONE: a powerONE controller (physical hardware) 

¶ powerONE firmware: the software running on the powerONE controller 

¶ VAR: a value added reseller 

¶ OEM: an original equipment manufacturer 

Introduction  
The powerTWO application is a graphical user interface (GUI) that manages powerONE designs. 

Designs can be created, modified, and downloaded to one or more powerONE controllers.  Designs 

can be monitored by powerTWO, showing current values interactively.  Design values can also be 

recorded for later analysis. 

Downloading and installing a copy of powerTWO  
powerTWO has been qualified to run under Windows XP, Windows Vista and Windows 7. If you 

donõt have any of those available, itõs time to acquire one or pack up the unit. The following are the 

Windows XP interactions.  

Visit http://www.emspace.com, select QuickStart and download powerTWO.  You will then see: 

 

 
Click Run. 

http://www.emspace.com/
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Click Run again. 

This will start the powerTWO Setup Wizard. 
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Click Next. 

  

Click Next and Next at the next two windows. This will place powerTWO in  

C:\ Program Files\ Embedded Spaces Inc\ powerTWO\ , and it will create an application data directory to 

store powerONE device descriptions. 

For Win7 the top directory will be Program Files (X86). 
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Create a directory for your designs, for instance a folder in your laptop called P2_pox, and copy any 

design files (.pox) you have, into it. Ask customer support for some relevant samples if you have 

none. 

Now start up powerTWO. It will locate the latest version of powerTWO and suggest that you load 

it. ò powerTWO update is availableó. Select it to start the update manager, close powerTWO and follow 

the instructions. After the download and install completes, start powerTWO. It may request a 

windows restart. A restart will only be required if the Microsoft .Net Framework requires installation 

or updates. 

Now connect the USB cable to your computer and to the mini USB plug on the front of  the 

powerONE (there is another plug at rear, but that one is ODBII). You donõt need a +12 (Vbatt) 

source yet. powerONE is happy on USB power. 

Win7 may just register the powerONE as an unspecified device. In that case go to; 

Control Panel > Devices and Printers and youõll see it as òUnspecifiedó.  

Right click on it and select Install from that menu and it will bring up this wizard.  

XP and Vista will go directly to the wizard. 

 
Now, the last steps in the installation: 

¶ Windows will now go through the install wizard for USB devices 

¶ Select No, not this time 

¶ Select Install from a list éé 
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¶ Select Search from the best driver in these locations and browse to 

C:\ program files\ Embedded Spaces Inc\ powerTWO.  

¶ On Windows 7, use C:\ Program Files (x86)\ ... instead 

¶ It will install the powerONE as a com port 

¶ The next time you attempt to use the powerONE, powerTWO will tell you if it needs to 

download any information for the powerONE device to your host PC 

¶ Select the Tools> Options pulldown 

o Select the Design tab and choose degrees F or C. 

o Select the General tab and Re-open last files at Startup; this option ensures that any 

designs you last had open are opened again whenever powerTWO starts. 

o Change anything else to taste but leave Search and Events alone unless directed there 

by Customer Service. 

Software Updates  
By default, powerTWO will periodically check for software updates (both for powerTWO and for 

powerONE). Update checking takes only a few seconds. We strongly encourage users to enable 

software update checking and to apply any updates that are available. 

Software update checking requires an active internet connection.   

If your firewall notifies you that an application ESIpowerTWO.exe is attempting to access the 

internet, it is the powerTWO application and you should let it proceed. 

Similarly, if your firewall notifies you that an application ESIUpdateManager.exe is attempting to 

access the internet, it is the Update Manager that wants to download new updates, and you should 

let it proceed. 

When An Update Is Available  

A powerTWO Update  

Normally, powerTWO is configured to check for powerTWO updates when it starts.  

If an update is available, a notification appears in the task bar area, as follows: 

 

You can then click the notification to run the Update Manager which will download and install the 

newer powerTWO. If your current version of powerTWO is 1.2.79 and a newer version 1.2.81 is 

available, the Update Manager would appear as follows: 
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Click Update to download and start installing the newer version of powerTWO.  Note that 

powerTWO cannot be installed while it is running, so the Update Manager will prompt you to close 

powerTWO if you havenõt done so already. 

Alternately, updates can be checked for at any time with Help->Check for Updates. 

A powerONE Update 

Notification for powerONE updates only occurs when you perform a powerONE related target 

operation, such as downloading or monitoring a design. 

For example, when downloading a design, you might receive notification of an available powerONE 

update, as follows: 

 

Click Ok to install the new version to all applicable powerONE devices.  
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You have the option to ignore the powerONE update for a day, or forever. If you have chosen to 

ignore the powerONE update, you can be reminded again by unchecking the applicable options in 

Tools->Options->Updates. 

Once you click OK, youõll be presented with a form that lists each attached powerONE device. 

Press Flash to update the firmware. 

Identifying powerONE controllers  

By Serial Number  
Every powerONE has a unique serial number. A unique serial number is required for all USB 

connected device to allow the Operating System to distinguish between multiple devices. 

By Firmware  Version  
Every powerONE has a firmware version. A version is indicated by V with a version number and 

the date and time that version was built; a unique serial number is included, as follows: 

powerONE V1.1.11 ð 2011/07/05 13:06:20; sn 81152724 

This identifies the powerONE as version 1.1.11, built at 2011/07/05 13:06:20.  The powerONE has 

a unique serial number of 81152724. 

powerONE controller status  
All powerONE target operations provide the status of each connected powerONE with respect to 

the operation being performed. 

The target status appears to the left of the controller description and may be one of: 

¶ Assign Serial Number: the powerONE does not have a valid serial number and a valid serial 

number must be assigned to it. 

¶ Incompatible: the powerONE is incompatible and needs newer firmware 

¶ Needs application: the powerONE does not have valid firmware 

¶ Needs download: the powerONE needs a download of the current design or a download of 

newer firmware 

¶ Ready: the powerONE is ready to perform the requested operation 

¶ Unrecognized: the powerONE firmware is not recognized 

¶ Up to date: the powerONE is up to date and the requested operation does not need to be 

performed on it 

¶ Will Downgrade: the powerONE has more up to date firmware than the firmware that is 

about to be programmed into it 
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Creating Designs 
Create a new, empty, design with File->New.  Save the new design with File->Save to a folder of 

your choice. 

Creating Design Objects 
On the main tool bar, you will see the following tool icons: 

 

These same icons are also accessible on a popup menu if you right-click in the design. 

When you click on any of the icons above and move the mouse into the design, your cursor will be 

the tool icon that you have chosen.  To get back to a normal cursor, either select the pointer icon on 

the tool bar or press the ESC key. 

To create a new design object, click on the spot in the design where you want to place the design 

element. A dialog box will appear so you can configure the design object. 

Designs can contain only a certain number of design elements, depending on the type of the design 

element. For example, a design can contain only 1 Rpm design element, but up to 12 Led design 

elements.  After a design element is created, the cursor will return to a pointer if no more design 

elements of that type can be created. 

Quick Example #1 ɀ Rpm and 2 Leds 

Topics Covered 

¶ Creating and positioning design elements 

¶ Making connections 

For the purposes of this example, we are going to create a Rpm design element with 2 Rpm values, 1 

yellow Led that will light when the current Rpm value is at least 1000 and 1 red Led that will blink at 

a period of 250 ms when the current Rpm value is at least 5500. For the yellow Led, weõll choose 

Led0 which is the left-most Led on the front of the powerONE. For the red Led, weõll choose Led 

5, which is in the middle on the front of the powerONE. Last, but not least, we will connect the 

Rpm values to their respective Leds. 

Please note that, for illustrative purposes, this example omits many details. 

To create the Rpm design element, select the  Rpm tool icon and click in the design.  You will see 

the following dialog box: 
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The configuration of each design element is specific. For Rpm, we specify the number of engine 

cylinders and whether we have 4 strokes or 2 strokes. For this example, we also configure two Rpm 

values we are interested in (1000 and 5500), as follows: 

    

After we click Ok, the design element appears as on the right.: 

 

Next, we select the  Led tool icon and click in the design, but to the right of the Rpm design 

element.  We see the Led dialog box and configure the Led, giving it the name Shift, as follows: 
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After we click Ok, the Led appears in the design, as follows: 

 

Now, weõll add the second Led, this time clicking just under LED5, as follows: 

 

After we click Ok, the second Led appears in the design, as follows: 
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Finally, we connect the Rpm Value 1000 to the Activate input of LED0.  Likewise, we connect the 

Rpm Value 5500 to the Blink input of LED5. 

Connections are made by holding the mouse down over a connector (either a square or diamond) 

and dragging the mouse to another connector. To connect LED0, hold the mouse down over the 

square connector of Rpm Value 1000 and drag the mouse to the l connector of LED0. Similarly, to 

connect LED5, hold the mouse down over the square connector of Rpm Value 5500 and drag the 

mouse to the b connector of LED5. Once we have done this, we see the connections, as follows: 

 

Congratulations! We now have a, albeit, simple design that can be downloaded to the powerONE 

unit and run (as soon as we physically connect the Rpm input on the back of the powerONE). 

Design Element Changes 
Changes to design elements are categorized as major or minor.  Major changes change the 

functionality of a design, while minor changes do not.   

Major design changes that have not been saved are indicated by an asterisk (*) next to the design 

name.  Minor changes to designs that have not been saved are indicated by a plus sign (+). 

Major design changes require that the design be downloaded to the powerONE; minor design 

changes do not. 
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Connections 

Types of Connections 

There are two types of connections to any design element: an input connection and an output 

connection. An input can be connected to an output, and vice versa. 

In addition, a connection has attributes. Connections can only be made if each connector has the 

same attribute. 

Connection Attributes  

Logical Connections 

The most common connection attribute is a logical connection which is true or false. For design 

elements that have multiple logical input connections, extra indicators are used to show the 

functionality of the input connection.  

Recalling the above example, a Led has a normal logical input connection, indicated by l, that causes 

the Led to turn on or off, but it also has another logical input connection, indicated by b, that causes 

it to blink instead. 

The following is the complete list of logical connection attributes: 

¶ b: blink 

¶ c: clear 

¶ d: disable 

¶ e: enable 

¶ l: logical 

¶ o: override 

¶ p: preset 

¶ s: stepvalue 

¶ v: value 

¶ +: count up 

¶ -: count down 

¶ >: compare greater than 

Value Connections 

A value connection, indicated by v, outputs a value that can be received by a value input connection.  

Recalling the above example, the Rpm design element has a v connection that can be used to output 

the actual Rpm value (as opposed to a step). 
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Step Value Connections 

A step value connection, indicated by s, outputs the step value associated with a design element that 

can be received by a step value input connection.  

Recalling the above example, the Rpm design element has a s connection that can be used to output 

the actual Rpm step value (1 or 2). 

Connector Symbols  

Connector symbols are  rectangles or  diamonds. Rectangle connector symbols indicate 

connections that cannot be inverted while diamond connector symbols indicate connections that 

can be inverted. Where an output connection cannot be inverted, as indicated by a rectangle 

connector symbol, the output value may still be inverted if the input connection it is connected to 

has a diamond connector symbol. 

Recalling the above example, the l step output connections from the Rpm design element cannot be 

inverted, whereas the input connections to a Led can. 

Inspecting Connections  

To inspect a connection, rest the mouse over the connector symbol.  Text will display to indicate the 

type of connection, its attributes and what other connections it is connected to.  For example, 

inspecting the step 2 connection of the Rpm design element shows: 

 

Similarly, if we rest the mouse over the blink connector of Led 5, its attributes are shown, as follows: 
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Maximum Input Connections  

Making Connections  

To make a connection, hold the mouse down inside a connector symbol and drag the mouse to the 

desired connection. When the destination connection is reached, a text message will appear to 

indicate the connection being made. To make the connection, release the mouse.  To make a 

different connection, continue to drag the mouse to another connection.  To discard the connection, 

release the mouse anywhere in the design, just not inside a connector. 

Recalling the above example, connecting step 2 of Rpm to the blink connection of Led 5, shows: 

 

Deleting Connections  

To delete a connection, select the connection line with the mouse, not inside, but between any two 

connector symbols, then press delete. 

Moving Connections  

To move a connection, hold the mouse down over a connection line and drag the mouse to another 

connection. The connection furthest away from the mouse will be broken while the connection 

closest to the mouse will be maintained.  

Moving a connection and releasing the mouse outside of a connector symbol performs the same 

action as deleting a connection. 

Maximum Number of Connections  

The maximum number of connections in a powerONE design is 127 connections. 

Maximum Number of Output Connections  

Output connections can be connected to more than one input connection.  However, most input 

connections can only be connected to one output connection at a time (but, see below). 

Connection Loops 

Certain connections can result in loops and are disallowed. powerTWO will indicate loop 

connections when you attempt to make them. 

The sole exception applies to Timer or Delay design elements, whose outputs may be connected 

back to their inputs to retrigger the Timer or Delay.  
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Maximum Number of Input Connections  

To avoid ambiguity, the maximum number of inputs connections for all design elements (except for 

input connections to logical operators) is 1. 

For example, a value input connection cannot be connected to more than one value output 

connection. Similarly, a step value input connection cannot be connected to more than one step 

value output connection. 

Use logical operators to connect more than 1 logical output connection to a logical input 

connection. Use theOr operator if any one logical output connection should activate a logical 

input connection. Use the  And operator if all logical output connections should activate a logical 

input connection. 

Logical operators can have up to 8 logical input connections.  Multiple logical operators can be 

connected together to process more than 8 logical input connections, if required. 

In the following example, the red Led 11 is turned on whenever the Rpm input value is 6500 or 

higher, or when the water temperature (ECT) from Can is 95 ° Celsius or higher: 

 

Steps 
Any design element that has values can have associated steps.  Not unlike steps on a ladder, if you 

are on step 3 of a ladder, you are also above steps 1 and 2.  Recalling Example #1 above, the Rpm 

design element was configured with 2 Leds, as follows: 

 



powerTWO User Manual  17 

 

In this example, the Rpm design element has 2 steps with values 1000 and 5500. Any time the Rpm 

value is less than 1000, neither step 1 nor step 2 is true (or active).  When the Rpm value is, for 

example, 2350, step 1 is true, but step 2 is not.  When the Rpm value is 5500 or higher, both step 1 

and step 2 are true. 

Steps are a fundamental concept in powerONE designs. They are used in  Rpm inputs,  Can 

inputs,  User inputs (Analog, Frequency and Interval),  Count and  Input Decoder design 

elements. 

Step Value Sorting 

Step values are sorted in ascending order automatically. 

When a step value is changed, it is sorted in ascending order and its connections are moved. 

Adding A Step Value 

To add a new step value, double click the design element, increase the number of steps and enter a 

new step value.  The step values will be sorted automatically and their associated connections will be 

moved. 

Removing A Step Value 

To remove a step value, double click the design element and decrease the number of steps.  The 

highest step values will be removed along with their associated connections. 

Design Element Errors  

Errors in design element are flagged with an  error flag at the top of the design element.  Hold 

the mouse over the design element to show the errors. All errors in design elements must be 

resolved before a design can be downloaded to powerONE. 

Design elements that have errors are also displayed in red. 

Design Element Warnings  

Warnings in design elements are flagged with a  warning flag at the top of design elements. 

Warnings need not be resolved before a design can be downloaded to powerONE, but they indicate 

that the functionality of a design may be different than expected. 

Selecting and Moving Design Elements 

Selecting a Single Design Element 

To select a single design element, click the design element. 

Quick Moving a Single Design Element  

To quick move a single design element, hold the mouse down on the design element and drag it to 

the desired location. 
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Selecting Multiple Design Elements  

Using a Selection Rectangle 

Hold the mouse down outside of any design element and drag the mouse to make a selection 

rectangle that will select all design elements that it encompasses. Release the mouse to select the 

design elements. 

Once design elements are selected, Ctl-Click can be used to select or deselect additional design 

elements. 

Using Ctl-Click 

Ctl-Click a design element.  If the design element is not selected, it is selected. If the design element 

is selected, it is deselected. 

Using Shift-Click 

Shift-Click a design element to select all design elements between the first selected design element 

and the mouse position. 

Moving Design Elements with Mouse  

Once multiple design elements are selected, hold the mouse down over any selected design element 

and drag to move all selected design elements. 

Moving Design Elements with Cursor Keys  

Use the left, right, up or down cursor keys to move selected design elements in the indicated 

direction. 

Use Ctl with left, right, up or down to move the selected design elements 10 times as far as with just 

the cursor keys alone. 

Use Shift with left, right, up or down to move the selected design elements 25 times as far as with 

just the cursor keys alone. 

Inspecting Design Elements  

To inspect a design element, rest the mouse over the design element.  Text that describes the 

specifics of the design element will appear. When more than one design element is selected, no text 

will appear. 

Modifying Design Elements  

To modify a design element, double the design element. A dialog box with the specifics of the 

design element will appear, allowing modifications to be made. 

Aligning Design Elements  

Whenever two or more design elements are selected, their left sides or their tops may be aligned.  

With the design elements selected, right-click the mouse.  Choose Align->Left or Align->Tops. 
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Distributing Design Elements  

Whenever three or more design elements are selected, they may be distributed with equal spacing, 

horizontally or vertically. 

With the design elements selected, right-click the mouse. Choose Distribute->Vertically or 

Distribute->Horizontally. 

Managing Multiple Designs  
Multiple designs appear as multiple tabs. To switch to a different design, click its associated tab. 

Tool Icons  
The following Tool Icons are available on the main tool bar. These same Tool Icons are also 

available by right-clicking in a design. 

To create a new design element, selects its icon from the tool bar and drop it into your design with a 

mouse click. 

 

 
Normal cursor 
(or press ESC)  

User input or 
output  

Can (OBD-II) 
input  

Rpm input 

 
Led 

 
Switch 

 
Input Decoder 

 
Logical And 

 
Logical Or 

 
Logical Xor 

 
Timer or 

Delay  
MinMax 

 
Count Events 

 
Rslatch 

 
Compare 

 
Differentiator 

 
Integrator 

 
LogActive 

control  
Design Notes 

 
Ambient 

Light 

 
Ambient 

Temperature  
Vbatt  

 

Design degree 
units; c is 

Celsius, f is 
Fahrenheit 

 
Warnings 

 

Downloading a Design 
Once a design is created and contains no errors, it can be downloaded to a powerONE with the 

Download command available on the tool bar. After the design is downloaded, the powerONE will 

restart and start running the downloaded design. 

Designs are downloaded over USB. 

Designs can be downloaded to more than one powerONE if multiple powerONEs are connected. 



powerTWO User Manual  20 

 

Monitoring a Design 
Once a design has been downloaded, the actual values and connection states of the design running 

on the powerONE may be monitored with the Monitor command available on the tool bar. 

To stop monitoring, use the Stop Monitor command on the tool bar (only visible when monitoring). 

Major design changes cannot be made while monitoring is in progress. Minor changes, such as 

moving design elements, can be made. 

Monitoring data is sent to the host PC via the USB connection on the front of the powerONE. 

The following design shows our now familiar example when the current Rpm value is 1302: 

 

Note that Rpm step 1 is highlighted because the Rpm value is 1000 or higher and that the 

connection to Led 0 is blue because it is active. 

When the Rpm value reaches 6054, the design will be shown as: 

 

Note that both Rpm steps are now highlighted, that both connections are now blue and that Led 5 

is shown in red when it was captured (though it will be blinking). 

Recording Telemetry from a Design 
Once a design has been downloaded, the actual data values may be recorded from the 

powerONEwith the Record command available on the tool bar. 

Designs cannot be modified while recording is in progress. 

Recording data is sent to the host PC via the USB connection on the front of the powerONE. 

To record, choose the sample rate and how long to record for. 
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Recording also allows an option to add a timestamp to the text file name. Use this option if you 

want to record multiple runs of the same powerONE without overwriting previous recorded data. 

To stop recording before all requested samples have been recorded, click Stop Record available on 

the tool bar (only visible when recording). 

Recorded Data File Names 

Recorded data is available in a text file in the folder that you chose at the beginning of recording. 

The text file can be imported into a Spreadsheet application. 

The name of the text file is powerONE-Record-<timestamp>-<serialnumber>.txt if the timestamp 

option was chosen, powerONE-Record-<serialnumber>.txt if the timestamp option was not 

chosen. 

Logging Designs 
As opposed to recording data, the powerONE can log design data in non-volatile onboard memory. 

The onboard memory, however, is limited (depending on the powerONE hardware version), as 

compared to recording data. 

Data is logged only when the design contains a LogActive design element and then only if the input 

to the LogActive design element is true.  This allows conditions to be defined under which data is 

logged. 

Logging data is a good choice when it is not possible to locate the host PC inside the vehicle while 

the vehicle is in operation. 

To log designs, first download your design to the powerONE. Then, configure the data to log using 

Actions->Logging->Configure.  After operating the vehicle, connect a host PC to the USB 

connection on the front of the powerONE and select Actions ->Logging->Get to get the logging 

data. 

Logging data is configured by specifying the interval at which the data is to be logged and by the 

amount the data has to change before it is logged. 

Once the onboard logging memory fills, the oldest logging values are replaced by newer logging 

values. 

Logging Data File Names 

Logged data is available in a text file in the folder that you choose when logging data is retrieved. 

The text file can be imported into a Spreadsheet application. 

The name of the text file is powerONE-Log-<serialnumber>.txt. 
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Units Management  
The User input types [Analog, Frequency and Interval] each carry engineering-unit definitions which 

are properties of the data coming in that particular UserIO. The units are passed along with the data 

and are considered by powerONE every time it handles an input datum.  

Default Units  
The default units are: 

¶ Volts: for an analog input 

¶ Hz: (hertz) for a frequency input and 

¶ ms: (milliseconds) for in interval input 

¶ Rpm 

User-defined Units  
We often wish to use other units to express a control or monitoring design. The default units (Volts, 

Hz, ms, Rpm) are pre-populated, but  we add our own units from the Action Menu item òUser 

Unitsó. The precision specified defines the displayed precision when a value is monitored. This 

menu is also accessible from the User-input specification pulldown for units, item .manage. 

 

The latch is a special case: 

¶ If its value input is connected to another object it inherits the units with the value. 

¶ If its value comes only from a preset, then it must select the units to accompany the value 

Calibration  
User Inputs may be defined in their native units: 

¶ Analog Input ð Volts 

¶ Frequency Input ð Hz 

¶ Interval Input ð ms 



powerTWO User Manual  23 

 

¶ Rpm Input ð Rpm 

Or, they may be calibrated in one of the user-defined  unit systems. In this example an analog input 

is calibrated to convert an accelerometer input (which is really volts) into fpsps. This is feet/sec/sec, 

usually written as fps2, but we canõt handle the superscripts. We donõt express it in Gs because weõll 

want to calculate real speeds and distances from this input. 

  

powerTWO generates the coefficients a and b of the straight-line equation 

y = ax + b; and loads them into powerONE. It then performs this calculation at every input update. 

Not all sensors are linear and powerONE can also handle the quadratic equation 

y = ax2 + bx + c.  This 2nd order calibration simply requires that we specify three values and 

powerTWO extracts the three coefficients; a, b and c and loads them into powerONE. 
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Unit Conversions  
Some design elements must convert values from one unit system to another 

Unit conversions are linear, so the designer must supply a scale and offset.  

There are two forms of conversion: 

¶ Scale then Offset: multiply the user unit by a scale, then add an offset 

¶ Offset then Scale: add an offset to the user unit, then multiply by a scale 

For example, to convert a user unit from Celsius to Fahrenheit, the conversion form would be Scale 

then offset, the scale would be 9/5 and the offset would be 32. 

To convert from Fahrenheit to Celsius, the conversion form would be Offset then Scale, the scale 

would be 5/9 and the offset would be -32. 

A Comparator would normally change units only when its two inputs are of the same type but from 

a different system. In this case itõs comparing two speeds, but one is feet/sec and the other miles/hr. 

 

 

We had already given the rule for this conversion using the Action Menu item òUser Conversionsó. 

  
 

The conversion menu is also accessible from the .manage item on any conversion select. 
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Integrators and differentiators normally change units. 

An integrator performs a time integral and is used to change things like acceleration to velocity, fuel-

flow to mass, and current to charge, etc. So anything that is ft/sec2 to ft/sec, lb/sec to lbs or 

amperes to ampere-secs (coulombs).  

A differentiator measures the rate of change of a value and is the complement to an integrator. If we 

have a velocity input, a differentiator will tell us the acceleration. For a changing weight input in lbs 

it will give use change rate in lb/sec.  

Units  checking  
powerTWO validates the unit consistency as a value is passed from one object to the next. Normally 

the units are just passed along also, but when a value is passed to an object that has its own unit 

definition, they must match and powerTWO will show a diagnostic if they do not.   
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Design Elements 

 User 
A User design element corresponds to one of the 8 UserIO connections on the back of the 

powerONE, numbered from 0 to 7. 

All user design-elements can be given a user-defined name to indicate their purpose. 

UserIOs can be configured as inputs or as outputs.  

User inputs can further be assigned as Analog, Freq, Interval or Sense.  

User outputs can further be assigned as Control, Pwm Entry or Pwm Table. 

UserIOs are identical with two exceptions: 

¶ User2 through User7 can sample at 200 Hz when used as Freq inputs and can handle a wide 

range of input voltages. User0 and User1 can sample at 10,000 Hz when used as Freq inputs, 

but require a ôhighõ input level of at least 11.5Volts. 

¶ User6 and User7 can modulate at up to 2,000 Hz when used as Pwm outputs, whereas User0 

through User5 can modulate at up to 200 Hz when used as Pwm outputs. 

User Inputs  

Sense User Inputs 

A sense user inputs reads a logic input, determines whether the input is high or low and outputs a 

logical value. The following example shows a sense input which is connected to the ignition circuit 

of an òalways-poweredó powerONE. 

      

When created, the sense user input appears as on the right. 
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Analog User Inputs 

Analog user inputs read voltage inputs and convert them to digital values.  Voltage inputs may vary 

from 0 to 17.8V V.  Higher voltages are clamped at this level and will not damage a powerONE 

unless they exceed 50 Volts. 

Analog user inputs provide the digital value, the associated step value and steps as outputs. 

See the òUnits Management sectionó for Units selection, definition and calibration. 

The sensitivity for an analog input is how much the input value must change before a change is 

recognized. 

The following example is an analog input calibrated to an ECT(Engine Coolant Temperature) 

sensor. The sensor has an output voltage of 12.0 at  0 degrees and an output voltage of 3.0 at 250 

degrees, with 2 steps (150 and 210), as follows: 

       

When created, the analog input appears as on the right. 

See the òUnits Management sectionó for Units selection and definition and for calibration. 
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Freq User Inputs 

Freq user inputs measure the frequency of a logic input, i.e. how often the logic input changes.  

UserIOs 0 & 1 measure frequencies up to 10 kHz and require an input high level of 11.5 Volts or 

more. UserIOs 2 to 7 measure frequencies up to 200 Hz. 

Freq user inputs provide the frequency value, the associated step value and steps as output. 

The following example is a frequency input calibrated to a magnetic sensor on a driveshaft. 

With a 3.43 differential & 20" tire (5.24 ft. in circumference) 

1 shaft rev = 5.24/3.43 = 1.53 ft 

88 fps (60mph) =  57.6 Hz   

Weõve chosen steps at 176 fps and 220 fps (120 and 150 mph), as follows: 

       

When created, the Freq input appears as on the right.  

See the òUnits Management sectionó for Units selection and definition and for calibration. 
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Interval User Inputs  

An Interval user input measures the interval, in ms, between changes in the logic input signal. Its 

actual resolution is 2.5 msec. Whether intervals in logic input signal are to be measured for the logic 

signalõs high or low state must be specified. 

Interval user inputs output the interval value, the associated step value, and steps. 

The following example is a interval input calibrated to a magnetic sensor on a front wheel. 

With a 20" tire (5.24 ft circumference) 

88 fps(60 mph) = 16.8 Hz 

Weõve chosen steps at 176 fps and 220 fps (120 and 150 mph), as follows: 

     

When created, the Interval user input appears as on the right: 

See the òUnits Management sectionó for Units selection and definition and for calibration.  


























































